
 Dreamweaver MX 2004, Menu by Menu 

File Menu 
The commands in the File menu control the open Dreamweaver document as a whole. They also include 
basic file functions like saving and quitting.  

 • New. Opens the New Document window, which lets you select a new blank document of many different 
types, from basic HTML page to dynamic PHP page. This window also lets you access templates you’ve 
created for your site. 

 • Open. Opens the standard Open File dialog box so you can choose an existing Dreamweaver document 
to open. You can set the Show pop-up menu to show only specific types of documents—only HTML or 
style sheets, for example. The Preview button displays a thumbnail image of the document, if one is 
available.  

 • Open Recent. Displays a submenu that lists the 10 most recently opened documents. Selecting a 
document from the list opens it.  The last option in this menu, “Reopen Documents on Startup,” is kind 
of cool. If you quit Dreamweaver when any documents are still open (and this option is checked), the 
next time your startup Dreamweaver, those documents will automatically reopen.  

 • Open in Frame. Opens an existing HTML page within one frame of a frameset. To make this command 
available, you must first click inside a frame to select it—not just in the Frameset document. The Select 
HTML file dialog box opens and lets you navigate to the file you wish to insert into the Frame. You can 
also choose to make the file’s URL relative to the document or the root folder, as described in Chapter 4. 

 • Close. Closes the open Dreamweaver document. If you have unsaved changes, Dreamweaver gives you 
the opportunity to save them. 

 • Close All. Closes all currently open documents. If you have unsaved changes, Dreamweaver gives you the 
opportunity to save them. 

 • Save (Save Frameset/Save Frame). Saves any changes you’ve made to your document. The Save 
command is dimmed if you haven’t made any changes to the document since the last time you saved it.  

Note: If you are working on a frames-based document, this command may say Save Frameset or Save Frame, depending on what’s 
selected. 

 • Save As (Save Frameset As/Save Frame As). Saves a copy of the current document under a new name, 
closing the original version and leaving the new version onscreen. Here again, if you’re working on a 
frames-based document, this command says either Save Frameset As or Save Frame As, depending on 
what’s selected. 

 • Save All. Saves changes to all the open documents.  

 • Save to Remote Server. Lets you save the current file to any site for which you have defined a remote site. 
In other words, if you use Dreamweaver’s FTP feature to move your files to a Web server 
, this option lets you access that Web server directly. In fact, it lets you access any Web server for any 
Web site you’ve defined in Dreamweaver. Because of this, this option can be risky. You can accidentally 
save a file into the wrong Web site, or in the wrong folder of the right Web site.  Because of this, it’s 



generally better to use the Files panel and its “Put Files” button . 

 • Save as Template. Saves the current document as a template file with the suffix .dwt. The Save as 
Template dialog box appears, so that you can specify the template’s file name and indicate which site it 
belongs to. Dreamweaver automatically saves all template documents in a Templates folder in the 
selected site’s folder.  

 • Revert. Undoes any changes you’ve made to the document since the last time you saved it. 

 • Print Code. Prints the code (i.e. what you see in Code View) of the current document.  

 • Import. Allows you to import data from other sources into your Dreamweaver document, such as XML 
data into a Template document, HTML generated by Microsoft Word, or tabular data from a 
spreadsheet program like Microsoft Excel. (Use the submenu to specify which.) 

 • Export. Extracts tabular data, Cascading Style Sheet styles, or template data as XML from your 
Dreamweaver document, for use in other applications.  

 • Convert. Convert more modern technologies such as Cascading Style Sheets into code that’s 
understandable by older browsers. In addition, you can convert older HTML pages into XHTML – the 
new standard for HTML Web pages.  

 • Preview in Browser. Opens the current document in your Web browser. (You have to save your 
framesets before you can preview them.) By selecting Edit Browser List, you can add new browsers to, or 
delete browsers from, your browser list, or specify a preferred browser. 

 • Check Page. Checks the current page for a variety of problems such as broken links, code that is 
incompatible with various browsers, accessibility limitations, and invalid HTML or XML code. These 
same tools are available from the Results panel for checking an entire site’s worth of files – choose 
Window  Results  Link Checker, for example - 

 • Design Notes. Opens the Design Notes window , where you can add additional information 
about the document, set the status, and choose to have the design note appear whenever the document is 
opened. (Note: to use design notes on your site, you must make sure the Maintain Design Notes option 
is selected in the Design notes section of the Site Definition window.) 

 • Exit/Quit. Exits Dreamweaver. If any of your open Dreamweaver documents have unsaved changes, the 
program prompts you to save them before quitting. 

Edit Menu 
The Edit menu applies common document changes like copying and pasting. 

 • Undo. Undoes the most recent change made to your document. You can choose this command 
repeatedly to move progressively backwards through your changes.  

 • Redo (Repeat). Restores whatever changes you just made by using the Undo command. Selecting Redo 
multiple times moves you progressively forward through changes you’ve undone. If you’ve just 
performed an operation other than Undo, Repeat instead of Redo will appear. This lets you repeat the 
last action. For example if you just pressed the delete key, the Repeat command will press the delete key 
again. 

 • Cut. Deletes the selected text or objects from the document and copies them to the invisible Macintosh 
or Windows Clipboard so they can be pasted elsewhere. (The Clipboard holds only one selection at a 
time.) 

 • Copy. Copies the selected text or object to the Clipboard so it can be pasted elsewhere—without 
disturbing the original. 

 • Paste. Places the most recent selection from the Clipboard into your document at the insertion point. 

 • Clear. Deletes the selected text or objects from the document without placing it on the Clipboard.  



 • Copy HTML. Copies a selection from Dreamweaver’s Design view , with its source code 
intact. You can then paste the selection into another program, complete with all HTML tags. 

Tip: If you’re simply copying and pasting between Dreamweaver documents, use the regular Copy command; Dreamweaver 
automatically preserves all source code.  

 • Paste HTML. Inserts source code copied from another application (or Dreamweaver document) into 
your document’s Design view, preserving the selection’s HTML tags. (Here again, if you’re simply 
pasting a selection you copied from the Design view of another Dreamweaver document, use the regular 
Paste command instead.) 

 • Paste Text. Pastes only text with no additional formatting. For example, if you use the regular paste 
command to paste text from Word, basic formatting such as bold, italics, and bulleted lists is preserved. 
If you just want the text – no formatting – use the Paste Text command. 

 • Select All. Selects everything in the document so you can make document-wide changes in one fell 
swoop.  

 • Select Parent Tag. Increases the current selection to include everything within the parent tag, including 
its content. For example, if you had a table cell selected, this command would increase the selection to 
the entire table row. Choosing the command a second time would increase the selection to include the 
entire table. In short, this command ensures that any changes you make apply to the entire tag.  

 • Select Child. Decreases the current selection to include everything within the child tag, including its 
contents. If you selected a table row, choosing this command would decrease that selection to only 
include the table cell and its contents. 

 • Find and Replace. Opens the Find and Replace window, which you can use to search the document—or 
entire site—for a specific word, tag, or source code and replace it with something different . 
This command lets you make such changes either en masse or one instance at a time. 

 • Find Selection. This command lets you find another instance of the current selection. For example, say 
you’ve selected the word “Mothball” on the page. Choosing this command will search the page for 
another example of “Mothball”.  

 • Find Next. Uses the most recent search settings from the Find and Replace window to search the current 
document, highlighting the next instance of the requested search item.  

 • Go to Line. Opens the Go To line dialog box. Type a number and Dreamweaver positions the cursor at 
the beginning of the specified line of code (Available only in the Code View.) 

 • Show Code Hints. Immediately displays any code hints (overriding the delay set in the Preferences) 
available for the current tag. Code Hints, provide a pop-up menu of tag 
properties appropriate for the current tag. (Available only in the Code View.) 

 • Indent Code. Adds one indent before the selected line of code. (Available only in the Code View.) 

 • Outdent Code. Removes one indent from the selected line of code. (Available only in the Code View.) 

 • Balance Braces. When you’re editing a script in Code view, this command helps you check for 
unbalanced braces (that is, an introductory { without a closing }) by highlighting the matching tags 
enclosing the selected code.  It doesn’t do anything for plain HTML, but if you’re writing a JavaScript 
program, or using a dynamic programming language like PHP or ASP, it can help identify missing braces 
– a common source of programming errors. Works with () as well. 

 • Repeating Entries. Lets you cut, copy, paste and delete repeating regions in templates. 

 • Edit with External Editor. If you haven’t already specified an external HTML code editor to use when 
editing large amounts of source code, such as BBEdit or Notepad, this command opens the Preferences 
window so that you can find and select one on your hard drive. Once you’ve specified an editor, this 



command opens the current document in that editor.  

 • Tag Libraries. Lets you modify the way Dreamweaver writes code for various types of tags – HTML, 
ColdFusion, ASP, and so on. You can create new tag libraries for working with other types of tag-based 
languages, or modify the ones that ship with Dreamweaver. 

 • Keyboard Shortcuts. Opens the Keyboard Shortcuts window and shows you all of the current keyboard 
shortcuts for Dreamweaver. You can create a new set of shortcuts for specific sites or programs, or export 
the settings to HTML to share with others. (You must duplicate the factory settings before you can add 
or delete your own shortcuts.)  (In Mac OS X, this option appears under the 
Dreamweaver menu.) 

 • Preferences. Opens the Preference window, which is full of options that customize the way Dreamweaver 
works. There are 16 categories of preferences, including the color and format of different HTML tags, 
shorthand for CSS styles, and the order in which panels appear on the screen.  (In Mac OS X, this option 
appears under the Dreamweaver menu.) 

View Menu 
The View menu controls the appearance of the document window. A checkmark in the menu lets you know 
which view you’re in.  

 • Code. Displays the file’s source code. 

 • Design. Displays the file’s visual design. 

 • Code and Design. Splits the document window into two panes: source code on top, visual design on the 
bottom. You can adjust how much of each pane is visible by dragging the center divider up or 
downward. 

 • Switch Views. Switches between the Code and Design views. 

 • Refresh Design View. Updates the Design view to reflect changes you’ve made directly to the source code 
in either Code view or split (Code and Design) view. 

 • Head Content. Opens a new menu bar in the main document window that contains shortcuts to 
accessing the file’s Head contents. You can use these menu items to highlight your document’s Title tags, 
Meta tags, and scripts, and then edit their content in the Properties Inspector.  

 • Noscript Content. When inserting JavaScript code into the document window, you can also include 
what’s called “Noscript” tags – information that appears in browsers that don’t understand JavaScript (of 
which there are very few.) After selecting this option all information inside of noscript tags will appear in 
the document window. To hide this information select this menu option again. 

 • Table Mode. Lets you switch between the standard table view, Expanded Tables view and the layout table 
view. When in the layout table view, you can also choose to have your tables display helpful 
tabs (by choosing the Show Layout Table Tabs subcommand) which make it easy to adjust the table’s 
dimensions, make columns autostretch, or add spacer images. 

 • Visual Aids. Lets you summon onscreen symbols that represent typically invisible page elements like 
image maps, anchors, and borders. 

 • Code View Options. Lets you adjust the appearance of your HTML code in Code view. You can turn on 
(or off) options that wrap lines of text to fit in the document window, add line numbers, highlight 
invalid HTML, turn on syntax coloring, or indent lines of code. 

 • Rulers. When you choose Show, Dreamweaver displays rulers along the top and left sides of document 
window. Using the options you find here, you can choose your ruler units: pixels, inches, or centimeters. 
You can also reset the orientation of the two rules so that both start from zero in the upper-left corner of 
the screen. 



 • Grid. Places a grid of vertical and horizontal lines over the document window to use as a guide when 
drawing your layouts. Selecting Edit Grid opens the Grid Setting dialog box, where you can adjust your 
grid’s colors, spacing, behaviors, and line appearance. 

 • Tracing Image. Adjusts the document’s background tracing image. You can load a new tracing image, 
make a current one visible, or adjust its position. 

 • Plugins. Lets you “play” browser plugins within the document window to test embedded media. You can 
choose to play a document’s plugins one at a time, or all at once, to simulate how the page will look to 
your viewers. 

 • Hide Panels (Show Panels). Hides all open panels. If panels are already hidden, the command says Show 
Panels instead and restores the panels to their original positions. 

 • Toolbars. Displays toolbars for use with Dreamweaver. Select Document from the submenu to display  
the Toolbar menu at the top of the document window. This menu offers common commands like the 
document’s View settings, page title, file management options, code navigation options, and browser 
preview. The Standard toolbar option displays a toolbar with common buttons for common commands 
such as opening files, closing files, cutting, copying and pasting content. 

Insert Menu 
The Insert menu adds selected page elements to the document at the insertion point’s position. The 

commands listed here correspond to the buttons on the Objects panel.  

 • Tag. Opens the Tag Chooser window which provides access to all of the tags – not only HTML, but any 
tag Dreamweaver has stored in its Tag Library (see entry under the Edit menu above). You can insert any 
tag and set any of its properties from this window, however Dreamweaver won’t make sure you’re 
inserting the tag correctly, so you should understand HTML (or the tag language you’re using) before 
trying this option.  

 • Image. Inserts an image file, such as a JPEG or GIF, into the document. The Select Image Source window 
appears and lets you navigate to the file you want on your hard drive. You can choose to make the URL 
for the file relative to either the document or the Site Root. 

 • Image Object. This menu lets you insert placholder graphics, rollover images, navigation bars, or 
HTML from Fireworks. 

 • Media. Inserts other types of media files, including Flash, Shockwave, Generator Applets, Plug-ins, and 
Active X. In most cases, the standard Select File window appears, which you can use to navigate to the 
desired file.  This menu also lets you insert Flash text, Flash buttons, and the new Image Viewer Flash 
element. 

 • Table. Inserts a new table into the document. The Insert Table dialog box appears and lets you format 
the table by specifying the number of rows and columns, the table width, and measurements for cell 
padding, cell spacing and the table border. 

 • Table Objects. Provides methods to insert tabular data (see the Import entry under the Edit menu 
above) and add other table-related tags such as the <th> --table header – tag into the page. The tag 
options listed under this menu item  assume you understand HTML and merely insert the tags, without 
making sure you’re doing it correctly. 

 • Layout Object. Lets you insert layers, divs, table layout cells, and table layout tables. In other words – 
different objects for designing and laying out a page. 

 • Form. Inserts Form Objects—the form tag, text fields, buttons, checkboxes, or lists—into the document. 
(If you have not already inserted the Form tag, Dreamweaver prompts you to do so.) 

 • Hyperlink. Inserts a link. The insert hyperlink dialog box lets you specify the text that should appear 
inside the link, the file to link to, as well as many other link options such as target and tab index.  



 • Email Link. Creates a new email link at the insertion point. The Insert Email Link dialog box appears; 
specify both the email address and the link’s text (such as “Click to email me”).  

 • Horizontal Rule. Inserts a horizontal line into the document. You can specify its width, height, and 
alignment in the Properties window. 

 • Date. Inserts the current date into the document. The Insert Date dialog box lets you format the 
appearance of the day of the week, the date, and the time. You can also elect to have the date 
automatically updated each time the document is saved.  

 • Named anchor. Inserts a named anchor for add links within a page. 

 • Comment. Inserts an HTML comment into your page. This comment isn’t viewable in Web browsers, 
but in Dreamweaver’s design view appears as a little gold shield. Use these to leave notes for you others 
about specific information about a page. For example, a comment indicating where an ad should be 
placed, can help someone updating the page, know what to do. 

 • HTML. Menu including lots of specific HTML tags, such as a horizontal rule, frames, text objects (many 
of which are also available under the Text menu, script objects for JavaScript and head tags that go in the 
head portion of a Web page including metatags such as keywords and descriptions used by some search 
engines. 

 • Template Objects. When working on a template file, this menu option lets you insert many of 
Dreamweaver MX’s new template features such as optional, editable and repeating regions,  

 • Customize Favorites. Lets you add your favorite objects from the insert panel into a special “favorites” 
tag. So your most common objects, images, divs, rollovers, tables, can be just one click away. See page 
106 for more information.  

 • Get More Objects. Opens the Macromedia Exchange for Dreamweaver Web site in your browser. There 
you can search for, and download, new extensions and objects to add new features to your copy of 
Dreamweaver. Use the Commands−−> Manage Extensions command to add downloaded extensions to 
Dreamweaver. 

Modify Menu 
You can use the commands in the Modify menu to adjust the properties of common document objects: 
links, tables, and layers, for example.  

 • Page Properties. Opens the Page Properties window, where you can specify document-wide attributes 
such as the page title, background and link colors, page margins, and background image, or select a 
tracing image to use as a reference for designing the page.  

 • Template Properties.  Opens the Template Properties window, where you can modify settings for 
various template features such as controlling the visibility of optional regions, the properties of editable 
attributes, and the values of any template expressions you’ve created. 

 • Selection Properties. When this item is selected (as indicated by a check mark in the menu), the 
Properties Inspector palette is on the screen; you use it to edit the current settings for selected page 
elements. The list of options displayed in the Properties window change according to what type of page 
element is selected.  This has the same effect as choosing Properties from the Windows menu. 

 • Edit Tag. Opens a dialog box with detailed options for the HTML tag that’s active in the current 
document. This advanced feature is for the true HTML geek – it gives access to all of the properties for a 
specific tag (not just the ones Dreamweaver displays in the Property Inspector).   

 • Quick Tag Editor. Lets you edit an HTML tag without leaving the Design view. If nothing on the page is 
selected, the QuickTag editor prompts you to enter a new HTML tag at the insertion point (by choosing 
from the alphabetical menu). But if text or an object is already selected when the QuickTag Editor is 
opened, the window displays the selection’s HTML tags for editing.  



 • Make Link. Turns a highlighted page element (graphic or text) into a link. The standard Select File dialog 
box appears; choose the document you want to open when someone clicks the link.  

 • Remove Link. This command is available only when a link is selected or the insertion point is inside of a 
link. It deletes hyperlinks by removing the <a href> tag from the selected text or image. 

 • Open Linked Page. Opens the linked page in a new document window. This command is available only 
when a link is selected or the insertion point is inside of a link. 

 • Link Target. Sets a link’s target and defines whether the linked page will appear in the same browser 
window or a new one. You can choose from blank, parent, self, or top targets, or manually define the 
target in the Set Target dialog box. This command is only available when a link is selected or the 
insertion point is inside of a link. 

 • Table. Opens a list of options for modifying a selected table. You can adjust the number of rows and 
columns, add row or column spans, or completely clear cells’ defined heights and widths (Chapter 6). 

 • Image. Opens a list of options for modifying a selected image including optimizing it in Fireworks or 
using one of the new built-in image editing tools such as the crop, resample and sharpen tools. See page 
123. 

 • Frameset. Offers options for splitting the current page into frames . Or choose the Edit No 
Frames Content command to create alternative Web-page material that can be read by older browsers 
that don’t support frames. 

 • Navigation Bar. If you inserted an interactive navigation bar from the Insert menu, you can use this 
command to edit its settings or add new navigation elements.  

 • Arrange. Lets you change the Z-index (the front-to-back order) of overlapping CSS layers. You can 
choose to send a layer to in front of other layers, send it to the back, and so on. You can also tell 
Dreamweaver to prevent overlapping layers altogether. 

 • Align. When you’ve selected two or more layers at once (by Shift-clicking them, for example), this 
command allows you to align them either by their left/right sides, tops, or bottoms. You can also choose 
to make all of the selected layers the same width and/or height. 

 • Convert. Because some older Web browsers don’t support CSS layers, you can choose to convert a layer-
based layout into a single, large table. (Note that you cannot convert overlapping layers to a table.) You 
can also reverse the process by breaking up an HTML table into separate CSS layers. In this case, every 
table cell becomes a unique layer.  

 • Library. Lets you add selected document objects to the site’s Library file . You can also 
update the current document, or multiple documents, to reflect any changes you’ve made to a Library 
object.  

 • Templates. These commands affect template documents . Using these commands, you can 
apply a pre-existing template to the current page, separate the page from its template, or update the page 
to reflect changes made to its template. If the open document is a template file, you can use this menu to 
create or delete editable regions (remove template markup) and update all site files based on that 
template. You can also use this menu to add repeating template regions and editable tag attributes. 

http://www.sawmac.com/dwmx2004/DWmx_Ch12.pdf


Text Menu 
As you could guess, the commands in the Text menu format and modify the document’s text. 

 • Indent. Adds one level of indentation to everything within the current block-level element (paragraph, 
headline, bulleted list).  

 • Outdent. Removes one level of indentation from everything within the current block-level element. 

 • Paragraph Format. Applies a paragraph format, such as Heading 1, Heading 2, or preformatted text, to 
all of the text in the current block-level element. You can also choose None from the submenu to remove 
the paragraph formatting. 

 • Align. Aligns text in the selected paragraph to the left margin, center, or right margin of the document. If 
the paragraph is inside a table cell or layer, Dreamweaver aligns it with the left, center, or right of that cell 
or layer. 

 • List. Turns the selected paragraph into an ordered, unordered, or definition list. You can edit the list’s 
format by selecting the Properties option from the submenu. 

 • Font. Lets you choose from a list of common font combinations for application to the selected text. 
When displaying text, your visitor’s browser will move down the list of assigned paragraph fonts until it 
finds one installed on its system (Chapter 3). You can create your own combination of paragraph fonts 
by choosing Edit Font List from the submenu. 

 • Style. Applies pre-defined text styles, such as Bold, Italic, or Strikethrough, to the selected text.  

 • CSS Styles. Lets you create new CSS (Cascading Style Sheet) styles and apply them to selected text 
(Chapter 8). You can also choose to attach an existing style sheet to the current document, or export the 
document’s own style sheet for use in other sites. 

 • Size. Applies a new size to the selected text. Sizes range from 1 (the smallest) to 7 (the largest); as 
described in Chapter 3, HTML sizes are relative, and change depending on your visitors’ browser 
preferences. CSS offers a much better alternative to sizing text that is not only more flexible but also uses 
less code and is more in line with current Web standards and techniques (see Chapter 6.) 

 • Size Change. Increases or decreases the selected text’s size relative to the document’s basefont size (which 
is set to 3 by default).  The same note about CSS mentioned in the previous item applies here, too. 

 • Color. Opens the standard Mac or Windows color picker dialog box, so that you can choose a color to 
apply to the selected text. Macintosh: You can choose from a variety of color palettes, including CMYK, 
RGB, HTML (Web safe), HSV, and HLS. Windows: In general, the Property Inspector’s Color box is a 
better way to assign Web colors to text. 

 • Check Spelling. Checks the current document for possible spelling errors  

Commands Menu 
You can use Commands menu to apply advanced features to your Dreamweaver document. Some menu 
items, such as the Record commands, eliminate repetitive tasks; others, such as the Clean Up HTML 
command, fix common problems in a single sweep. 

 • Start/Stop Recording. Records a series of actions that can then be reapplied to other parts of the 
document (Chapter 19). When you select the Start Recording command, Dreamweaver records each of 
your actions until you choose Stop Recording. Note that Dreamweaver only retains one recorded 
command at a time.  

 • Play Recorded Command. Reapplies the most recently recorded command.  

 • Edit Command List. Opens a list of all saved commands. You can rename the commands or delete them 
permanently.  



 • Get More Commands. Opens the Macromedia Exchange for Dreamweaver Web site in a new browser 
window, so that you can search for, and download, new extensions or commands. Extensions are 
downloaded to your Extension Manager. (See Chapter 20.) 

 • Manage Extensions. Opens the Extension Manager, a program that lets you manage extensions you 
download from the Macromedia Exchange Web site (Chapter 20). The Extension Manager helps you 
install, delete, and selectively disable extensions. 

 • Apply Source Formatting. Changes you make to Dreamweaver’s HTML source formatting (which is 
defined in the Preferences window and the SourceFormat.txt file) apply only to newly created 
documents. This command, on the other hand, offers a way to apply these formatting preferences to 
existing HTML documents.  

 • Apply Source Formatting to Selection. Same as “Apply Source Formatting” above, but applies only to 
whatever you’ve selected. In this way, you can make sure the HTML for a <table> is nicely formatted (by 
selecting it and applying this command) while the rest of your finely crafted HTML is left alone. 

 • Clean Up HTML/XHTML. Opens a list of options for correcting common HTML problems, such as 
empty tags or redundant nested tags. Once you’ve selected what you’d like to fix, Dreamweaver applies 
those changes to the current document and, if requested, provides a log of the number and type of 
changes made. (See Chapter 15.) 

 • Clean Up Word HTML. If you import HTML that was generated by Microsoft Word, you often end up 
with unnecessary or cluttered HTML tags that can affect your site’s performance. This command opens a 
list of options that can correct formatting problems common in Microsoft Word’s HTML. Dreamweaver 
applies your selected changes to the document and, if requested, displays a log of the number and type of 
changes made.  

 • Add/Remove Netscape Resize Fix. This command lets you insert JavaScript code into your document 
that counteracts a bug in some versions of Netscape Navigator (it causes pages that use layers to display 
incorrectly when the browser window is resized). The inserted code makes the page reload every time a 
browser window is resized.  

 • Optimize Image in Fireworks. Opens the selected image in Macromedia Fireworks’ Optimization 
window, where you can experiment with different compression settings to find the best balance between 
file size and image quality. If you used Fireworks to create the image in the first place, you can choose to 
use the original Fireworks PNG file or the selected image (GIF or JPEG file) as the source image. 
Dreamweaver then replaces the selected image with the newly optimized image.  

 • Create Web Photo Album. Lets you turn a folder of images into a Web-based photo album. The Create 
Web Photo Album window appears; specify a title for your album, the source folder, and so on (see 
Chapter 19). 

Note: This command requires Macromedia’s Fireworks image-editing program, which creates thumbnail and full-sized versions of each 
image. Dreamweaver then creates a Web site with one page displaying all of the thumbnail images. The thumbnails are linked to 
individual HTML pages containing the full-sized images.  

 • Set Color Scheme. Opens a list of preset Web-safe color combinations for a document’s background, 
text, and links. Using the Preview window, you can experiment with different color sets until you find 
one you like, and then apply it to your document automatically.  

 • Format Table. Opens a list of preset formatting options for your HTML table, including color schemes, 
text alignment and style, and border measurements. (Unavailable when a table is in Layout mode. 

 • Sort Table. Sorts the information in a selected table. You can choose to sort alphabetically or 
numerically, in ascending or descending order. This command cannot be applied to tables that include 
rowspans or colspans. 



Site Menu 
As its name suggests, the commands in this menu apply to your entire Web site, rather than to a one 
document at a time. These commands can help keep your Web site organized and promote collaboration 
between large workgroups. 

 • Manage Sites. Opens the Manage Sites Panel where you can create, delete or edit site definitions. 

The next five menu commands let you transfer files between your computer (the local site) and a Web 
server (the remote site). These commands, in other words, don’t work unless you’ve first defined a remote 
site in the Site Definition window. In addition, these operations work only files that you’ve selected in the 
Site window.  

 • Get. Copies files (those you’ve selected in the Site window) from the remote server to the local site folder 
for editing. Note that if the File Check In and Check Out feature is active, the downloaded files will not 
be editable. 

 • Check Out. Copies files (those you’ve selected in the Site window) from the remote server to your local 
site and marks them on the remote server as checked out. No one else will be able to make changes to the 
document until you upload it back onto the remote server. 

 • Put. Uploads files (those you’ve selected in the Site window) from the local site to the Remote site. The 
uploaded file will replace the previous version of the document. 

 • Check In. Uploads checked-out files from the local site to the Remote site and makes them available to 
be edited by others. Once a file is checked in, the version on your local site becomes Read-only 
(openable, but not editable).  

 • Undo Check Out. Removes the checked-out status of selected files. The file is not uploaded back to the 
remote server, so any changes you made to the file will not be transmitted to the Web server. Your local 
copy of the file becomes Read-only.  

 • Locate in Site. When working on a document, selecting this option opens the Site window and highlights 
that document’s file in the site’s Local folder. 

 • Reports. Opens the Reports window and lists options for generating new reports . Reports 
can monitor workflow (such as design notes and checkout status) and common HTML problems (such 
as Missing Alt text, empty tags, untitled documents, and redundant nested tags). You can generate a 
report on just the open document, multiple documents, or the entire site.  

 • Check Links Sitewide. Analyzes the current site for broken links, external links, and orphaned pages. 
Dreamweaver then generates a report listing all of the found problems. You can fix problematic links 
directly in the Report window—or click on the file name to open the errant file in a new document 
window with the link highlighted and ready to repair.  

 • Change Link Sitewide. In one step, replaces a broken link that appears multiple times throughout your 
site. In the Change Link dialog box, you first specify the incorrect link; below it, enter the link with which 
you’d like to replace it. Dreamweaver searches your site, replacing every instance of the old link. 

 • Advanced. Provides access to advanced site options such as: “FTP Log” which opens the FTP log -- a 
record of all FTP file transfer activity; “Recreate Site Cache” which forces Dreamweaver to rescan the 
site’s files and update its cache file to reflect any changes to the files or links in the site; “Remove 
Connection Scripts” for removing the script files Dreamweaver creates to work with dynamic, database-
driven Web sites;  “Deploy Supporting Files” to move necessary programming files to the Web server for 
using Dreamweaver’s ASP.NET server model to build dynamic pages. 



Window Menu 
This menu controls which panels and windows are visible or hidden at the moment. (A check mark in the 
menu denotes open panels.) 

 • Insert. Opens the Insert bar, from which you can insert various types of objects (such as images, layers, 
or forms) into your document. The Insert bar also contains options for switching between Layout and 
Standard table views and accessing options for dynamic Web pages. 

 • Properties. Opens the Property Inspector, where you can edit the relevant properties for a selected 
object. The options in the Property Inspector depend on which page element is selected. 

 • CSS Styles. Opens the CSS (Cascading Style Sheet) Styles panel, from which you can define and edit  CSS 
styles or apply existing ones to selected text.  

 • Layers. Opens the layers panel, which lists all of layers created using Dreamweaver’s layer tool, or all 
absolutely positioned CSS <div> tags. See Chapter 8 for more details. 

 • Behaviors. Opens the Behaviors panel, which lets you associate behaviors (such as swapping images in a 
Rollover or checking for needed plugins) to selected page elements. 

 • Snippets. Opens the Snippets panel which contains snippets of HTML, JavaScript and other types of 
programming code. You can create your own snippets to save your fingers from having to re-type 
frequently repeated code. 

 • Reference. Opens the Reference panel, a searchable guide to HTML tags, Cascading Style Sheets, and 
JavaScript commands. The guides are culled from the popular O’Reilly reference books and include an 
explanation of what specific tags do, when they can be used, what additional components are required, as 
well as tips for getting the most out of them. 

 • Databases. Opens the Databases panel for working with dynamic web sites. This panel lets you connect 
your site to a database, view the structure of a database and even preview data currently stored in the 
database. 

 • Bindings. Opens the Bindings panel which lets you create database queries for working with dynamic 
sites. In addition, the panel displays and lets you add dynamic data to a Web page. 

 • Server Behaviors. Opens the Server Behaviors panel, the control panel for viewing, editing and adding 
advanced functionality to dynamic Web pages. 

 • Components. Opens the Components panel, for use with Cold Fusion MX and  JSP sites as well as Web 
Services. This advanced feature lets Cold Fusion and JSP developers take advantage or pre-written self-
contained programs making building complex dynamic sites easier.  

 • Files. Opens the Files panel. From this window, you can open any file and transfer files between your 
computer and the remote server.  

 • Assets. Opens the Assets panel, which conveniently groups and lists all of the assets (such as colors, links, 
scripts, or graphics) you’ve used in your site.  

 • Tag Inspector. Opens the Tag Inspector panel which provides a listing of all properties available for the 
currently selected HTML tag. This uber-geek option is like the Properties Inspector on steroids. 

 • Results. Lets you open Dreamweaver’s many site tools such as the Find and Replace command, Link 
Checker and Reports command. Pick the type of sitewide action you’d like to perform using the sub 
menu.  

 • History. Displays the history panel for viewing a record of actions performed in the current document. 

 • Frames. Displays the frames panel for selecting frames and framesets for editing. 

 • Code Inspector. A window displaying the HTML code for the current document. You can edit the code 



directly in the window, while still looking at the design view. It’s often easier to just use Dreamweaver’s 
“Code and Design” view (View  Code and Design.) 

 • Arrange Panels. Returns all open panels or windows to their default positions on the desktop.  

 • Hide Panels. Closes all currently open panels. Choosing Show Panels reopens only those panels that were 
displayed before you selected Hide Panels. 

 • Cascade. (Windows only). The Windows interface for Dreamweaver provides a single environment that 
fills the screen. By default, a document fills the entire “document” area of the window. With multiple 
documents open, you switch from page to page by clicking on tabs that appear at the bottom of this 
document area. If you prefer to have all open documents floating and resizable within this space this and 
the next two options let you “undock” the current documents. The cascade option resizes each open 
document and places them one on top of the next. To redock your pages, just click the Maximize button 
on any currently opened document. 

 • Tile Horizontally (Windows only) Places all open documents side by side horizontally. The documents 
aren’t placed on top of each other; rather they fill the available document area. With more than a few 
documents open, this option displays so little of each page that it’s difficult to work on any one page. 

 • Tile Vertically (Windows only). Just like the previous command, except that documents are placed 
vertically on top of each other. 

 • Next document, Previous document (Macintosh Only). This pair of commands let you step through all 
of your open documents, bringing each document in turn to the front of the screen for editing. 

Help Menu 
The Help menu offers useful links and references for more information about using, troubleshooting, and 
extending Dreamweaver. 

 • Getting Started and Tutorials. Tutorials and setup information. 

 • Using Dreamweaver. Opens a reference guide to using Dreamweaver. Topics are organized by tasks, 
such as “Setting Up a Document.” 

 • Using ColdFusion. A reference guide for setting up and using ColdFusion MX, Macromedia’s dynamic 
server application. Includes information for creating ColdFusion web pages. 

 • Reference. Opens the Reference panel, a searchable guide to HTML tags, Cascading Style Sheets, or 
JavaScript, as described above.  

 • Extensions. Menu offers information on creating your own extensions. 

 • Dreamweaver Support Center. Opens Macromedia’s online Dreamweaver Support Center Web page in 
your browser. This Web site offers technical support for known bugs or common questions, 
downloadable updates to the program, and a link to online forums. 

 • Macromedia Online Forums. Opens an index of available online forums from Macromedia’s Web site 
(in your Web browser). You can use the forums to interact with other Macromedia customers, post 
questions, share techniques, or answer questions posted by others. Requires Internet access and a 
newsgroup reader. 

 • Activation. This is Macromedia’s method of registering a product and preventing illegal copying of their 

http://www.sawmac.com/dwmx2004/DWmx_Ch12.pdf


products. You can activate a product to make Dreamweaver MX 2004 work on your computer; transfer a 
license and register your copy of MX 2004. You’ll want to transfer the license if you have bought a new 
computer and plan on installing your copy of Dreamweaver on it. In addition, if you plan on wiping out 
your hard drive and reinstalling your operating system and programs, make sure you transfer the license 
first.  

 • About Dreamweaver (Windows only). Opens an About Dreamweaver window, showing your software’s 
version number. (On the Macintosh, this command is in the Dreamweaver menu.)  
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